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I. Introduction 
 

A. General Description 
 

The MS4500E is a hand‐held, battery powered, corrosion meter capable of measuring and storing data 
from all types of electrical resistance (ER) corrosion probes. The instrument is light weight, 
microprocessor‐based, and features a simple, menu‐driven interface using a keypad and a backlit 
graphical LCD display. 

 
Corrosion rate measurements are made using the electrical resistance method. Essentially, the instrument 
measures the resistance of the probe element which changes over time, as metal loss occurs. The rate of 
change is directly proportional to corrosion rate. This method finds a wide variety of applications since it 
can be used in conductive and nonconductive environments such as petroleum, chemical, water, soil, or 
even atmosphere. The new high‐resolution measurement of the MS4500E detects smaller increments of 
metal loss, providing faster response than traditional ER instruments. 

 
After taking a reading, the instrument displays metal loss in mils and corrosion rate in mils per year (mpy). 
The reading can then be stored to memory or discarded. All stored readings are automatically time and 
date stamped. Readings are stored to non‐volatile Flash memory which retains data without the need for 
a battery backup. 

 

The MS4500E High Resolution ER Data Logger can store 16,000 readings per probe on up to 250 different 
probes (4 million total). Stored data can be downloaded directly to a USB Flash (“jump”) drive in non‐ 
hazardous areas. Data can be opened and charted using the provided CDMS software, or can be imported 
into any standard data analysis (spreadsheet) program such as Microsoft Excel. Data can also be reviewed 
and charted on the instrument’s LCD display for quick reference. 

B. Principles of Operation 
 

The MS4500E High Resolution ER Data Logger operates on the Electrical Resistance (ER) technique and 
is used in conjunction with an ER probe. The ER probe utilizes a resistive sensing element 
manufactured from the material of interest (or a close approximation) which is exposed to a corroding 
environment. This is called the Exposed or Corroding Element. The resistance of the Exposed Element 
is directly related to its thickness, so as the element corrodes the resulting loss of metal causes a 
proportional increase in the element’s resistance. The probe also contains an internal Reference 
Element which is used to compensate for the influences of temperature on the Exposed Element. 

 
The MS4500E High Resolution ER Data Logger is designed to work with any standard ER probe, but it 
is recommended that Cylindrical and Large Flush type probes be used to ensure optimum 
performance. Their physical design places the Reference Element in closer proximity to the Exposed 
Element compared to other probe types, providing more effective temperature compensation and 
thus reducing the effects of thermal noise. 
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Because they are designed to corrode, ER probes are sacrificial in nature. Each ER probe will have a 
finite life that is based on the element thickness. ER probes are available in a number of geometries 
and thicknesses designed to suit a wide variety of applications. Table 1 lists the common ER element 
options available from Metal Samples and the effective life of each. 

 
 
 

Element Type Compatibility Thickness Probe Life 
(Span) 

  
Tubular Loop 

 
Compatible 

4 2 

8 4 

  
Wire Loop 

 
Compatible 

40 10 

80 20 
 

 

 
Flush (Small) 

 
Compatible 

4 2 
8 4 

20 10 
 

 

 
Cylindrical 

 
Preferred 

10 5 
20 10 
50 25 

 

 

 

Flush (Large) 

 

Preferred 

5 
10 
20 
40 

2.5 
5 

10 
20 

 

Table 1. Standard ER Probe Elements 
 
 

The MS4500E High Resolution ER Data Logger measures an ER probe utilizing a high‐resolution, 16‐bit 
measurement. This allows the unit to detect much smaller amounts of metal loss, thus responding 
faster to corrosion events and upsets.   At 16‐bit resolution the MS4500E ER Data Logger can  
measure metal loss amounts as small as 0.004% of the probe life.   For highly sensitive probes      
such as the 5‐mil large flush shown above, that results in a detection limit of less than one angstrom. 
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C. Technical Specifications 

Model MS4500E High Resolution ER Data Logger 

Physical Data 
Instrument Weight (w/ boot): 1.71 lb. (0.78 kg) 
Total Weight w/ Case & Accessories: 6.96 lb. (3.16 kg) 
Instrument Dimensions (w/ boot): 8.75"L x 4.54"W x 2.20"D (21.77cm x 11.53cm x 5.59cm) 
Instrument Dimensions (w/o boot): 7.50"L x 4.00"W x 2.00"D (19.05cm x 10.16cm x 5.08cm) 
Carrying Case Dimensions: 14.50"L x 11.38"W x 5.88"D (36.83cm x 28.89cm x 14.92cm) 
Operating Temperature: ‐4° to 140°F (‐20° to 60°C) 
Storage Temperature: ‐4° to 158°F (‐20° to 70°C) 
Operating Humidity Range: 30% ‐ 95% 

 
Performance Data 
Measurement Type: ER measurement using any standard ER Probe Types 

Preferred Probe Types: Cylindrical, Flush(Large) 
Compatible probe types: Tube Loop, Wire Loop, Flush (Small) 

Range: 0 ‐ 25,000 probe life units (displayed as 0.00 to 1000.00 PLU’s in 
0.04 increments) 

Resolution: 0.004% of Probe Life 
Repeatability: ± 0.1% of Full Scale 
Cycle Time: 25 Seconds 

 
Electrical Data 
Power Requirements: Four (4) AA Batteries ‐ Duracell PC1500 (or Duracell MN1500) 
Maximum Probe Cable Distance: 200 ft. (61 m) 
Download Method: Directly to USB Flash drive (in non‐hazardous areas only) 

 
Hazardous Location Certifications – Intrinsic Safety 
USA / Canada 
For use in Class I Zone 0 AEx ia [ia] IIC T4 Ga 
Ex ia [ia] IIC T4 Ga 
Class I, Division 1, Groups A,B,C & D, T4 
Provides outputs to Class I, Division 1 [Ex ia] 
‐ 25°C ≤ Ta ≤ + 60°C 
 

Europe and Worldwide (ATEX and IECEx) 
II 1 G Ex ia [ia] IIC T4 Ga 
‐ 25°C ≤ Ta ≤ + 60°C 
ATEX Certificate No: ITS18ATEX203161X 
IECEx Certificate No: IECEx ETL 18.0007X 

 

Included Accessories 
Carrying case, Probe Cable (1’ coiled ‐ 6’ extended), Meter Prover, Operation Manual, Corrosion Data 
Management Software, Protective Boot 

 
Optional Accessories 
Certified Data Transfer Unit 
Certified USB Barrier 
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II. Start‐up and Operation 
A. Receiving the MS4500E High Resolution ER Data Logger 

Check the MS4500E High Resolution Data Logger for any shipping damage when it is first received. 
When the unit is unpacked, verify that the following items are included: 

 
• Carrying Case 
• Data Logger 
• Meter Prover 
• User’s Manual 
• Probe Cable 

 
In the event of shipping damage, quantity shortage, or missing items, it is recommended that the 
event is documented immediately and that digital photographs are taken. Any shortages or missing 
items should be reported to Metal Samples immediately. In the event of shipping damage, a claim 
should be opened with the responsible carrier. 

 

B. Start‐Up 

CAUTION: Using this product in any way other than that specified within this manual may impair the 
intrinsic safety protection. 

 
ATTENTION : l'utilisation de ce produit de toute autre manière que celle spécifiée dans le présent manuel 
peut altérer la protection de sécurité intrinsèque. 

 

Start‐up of the MS4500E High Resolution Data Logger involves the following steps: 
1. Port Details and Probe Connection 
2. Power‐Up 
3. Setup and Operation 

 
1. Port Details and Probe Connection 

 

Attention: Utilisez Seulement 
dans des endroits Sécurisés 
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The MS4500E High Resolution Data Logger is supplied with a probe cable and it can be connected to 
the probe whose metal loss value needs to be measured, no additional hardware is necessary. 
Connect the probe cable ‘Lemo’ connector end to the data logger probe connector ‘J9’ available on 
top of the data logger. Connect the other end of the probe cable i.e. probe connector (MS 
Connector) to the probe. 

 
 
 

2. Power‐Up 
 

The unit is supplied with 4 AA batteries installed. The instrument can be powered up by pressing the 
‘ON’ button on the Keypad . The Start‐up screen with the Metal Samples logo will appear on the screen; 
the start‐up screen confirms the software version currently running and the SD card status. 

 

 
Display Window Power On Button 

 

     METAL SAMPLES        MS4500E/MS4500E-HC 
 

SELECT PROBE 
MAKE MEASUREMENT 
RECALL READINGS 
DELETE READINGS 
SET TIME & DATE 
SET MEASUREMENT TIMER 
COMMUNICATIONS 
LANGUAGE / IDIOMA / LINGUAGEM 
BACKLIGHT ON/ OFF 
POWER OFF 

FW-1890-02.00   12/15/2022 09:10:54 
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a. Safe Area Usage 
 

The MS4500E High Resolution Data Logger is approved for use in hazardous areas, but can be 
used in non‐hazardous areas as well. 

 
The data transfer from the unit to PC should be done in a safe area. A certified USB isolator 
should be used between the unit and PC for data transfer. 

 
b. Hazardous Area Usage 

 

CAUTION: This section provides general guidelines for hazardous area usage. However, 
regardless of anything stated here, the MS4500E High Resolution Data Logger must be used in 
full compliance with the control drawing located in Appendix A and all of the local area 
requirements. The entity parameters of the unit are given below. 

 
ATTENTION : Cette section fount des directives générales pour l’utilisation en zone dangereuse 
Toutefois, et indépendamment de toute déclaration faite ici, L’enregistreur de données de 
haute résolution MS4500E doit être utilise en pleine conformité avec le schéma de contrôle 
donne en page  20 et avec toutes les exigences du locale zone dangereuse. 

 

J9-USB Port 
Uo = 4.94V 
Io  = 0.332A 
Po = 0.410 W 
Co = 1.0 uF 
Lo = 100 uH 

J5 – Mini USB Port Entity Parameters: 
Uo = 4.94V 
Io  = 0.215A 
Po = 0.322 W

 
 

SPECIAL CONDITIONS 

• Connection of the equipment to the ET1867 USB barrier (or any other certified barrier used 
with the equipment) may only be made while both the barrier and the equipment are located 
in the non‐hazardous area. 

 
• External non‐metallic materials utilize a conductive coating to prevent the risk of electrostatic 

charging. The equipment shall be removed from service if damage to this coating is observed. 
Refer to the manufacturer’s instruction manual for further information on the durability and 
any chemical vulnerability of this coating. 

 
CONDITIONS PARTICULIERES 

 
• La connexion de l'équipement à la barrière USB ET1867 (ou toute autre barrière certifiée 

utilisée avec l'équipement) ne doit être effectuée que lorsque la barrière et l'équipement sont 
situés dans une zone non dangereuse. 

 
• Les matériaux externes non métalliques utilisent un revêtement conducteur pour éviter le 

risque de charge électrostatique. L'équipement doit être retiré du service si des dommages à 
ce revêtement sont observés. Reportez‐vous au manuel d'instructions du fabricant pour plus 
d'informations sur la durabilité et la vulnérabilité chimique de ce revêtement. 
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CAUTION: 

1. Mini USB port to transfer the data from the Data Logger to PC allowed only in safe area 
through certified USB barrier. 

 
2. Connection of the equipment to the Metal Samples # ET1867 USB barrier (or any other 

certified barrier used with the equipment) may only be made whilst both the barrier and the 
equipment are located in the non‐hazardous area. 

 
3. Only Certified USB flash drives are allowed to use in Hazardous locations. 

 
4. Conductive coating utilized on the equipment is permanently static dissipative and humidity 

independent, no further maintenance is necessary. The unit needs to be returned to 
manufacturer if any damages/scratches noticed on the outer surface of the equipment. 

 
• DO NOT USE CHEMICAL SOLVENTS TO CLEAN THE OUTER SUFRACE OF THE EQUIPMENT OR 

BOOT. 
 
 

ATTENTION: 

1. Mini port USB pour transférer les données de l'enregistreur de données au PC autorisé 
uniquement dans une zone sûre grâce à une barrière USB certifiée. 

 
2. Connexion de l'équipement aux échantillons métalliques # ET1867 La barrière USB (ou toute 

autre barrière certifiée utilisée avec l'équipement) ne peut être fabriquée que si la barrière et 
l'équipement sont situés dans une zone non dangereuse. 

 
3. Seuls les lecteurs flash USB certifiés sont autorisés à utiliser dans des endroits dangereux. 

 
4. Le revêtement conducteur utilisé sur l'équipement est en permanence antistatique et 

indépendant de l'humidité, aucun entretien supplémentaire n'est nécessaire. L'unité doit être 
retournée au fabricant si des dommages / rayures ont été constatés sur la surface extérieure 
de l'équipement. 

 
• N'UTILISEZ PAS DE SOLVANTS CHIMIQUES POUR NETTOYER LE SUFRACE EXTERNE DE 

L'ÉQUIPEMENT OU DE LA BOTTE. 
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c. Battery Replacement 
 

The battery compartment is located on the back of the instrument. You must first remove it to access the 
battery compartment. 
To replace the batteries, first loosen and remove the cover screw, then remove the battery cover to expose 
the batteries. Remove the old batteries and replace them with four new 1.5V ‘AA’ size batteries, being sure 
to follow the polarity (+/‐) symbols in the battery compartment. Replace the battery cover and cover screw. 
 

WARNING: 
 

• Do not mix old and new batteries. 
• Do not mix batteries of different types (such as alkaline and lithium.) 
• Duracell PC1500 battery is required for intrinsic safety. 
• The cover screw is used to prevent unauthorized tampering of the batteries and is required to ensure intrinsic 

safety.   
• Do not over-tighten the cover screw, as this may damage the instrument case. 

 
 

ATTENTION: 
• Avertissement ! Ne mélangez pas des piles neuves et usées. 
• Avertissement ! Ne mélangez pas des piles de types différents (telles que des piles alcalines etdes piles 

lithium.) 
• Avertissement ! La pile Duracell PC1500 est requise pour la sécurité intrinsèque. 
• Avertissement ! La vis du couvercle est utilisé pour éviter toute manipulation non autorisée des 

batteries, et est nécessaire pour assurer la sécurité intrinsèque. 
• Avertissement ! Ne pas trop serrer les vis du couvercle, pour ne pas endommager le boîtier de 

l'instrument 

 
 
 
 

 
Battery Compartment Lock Screw 
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3. Setup and Operation 
 
 

MAIN MENU 
 

The MS4500E allows you to measure metal loss and corrosion rate. Review this section which 
describes the functions that display on the Main Menu: 

 

 

Select the functions by using the up or down arrow and pressing ENTER or directly selecting the number 
using the keypad and press ENTER. Pressing ‘EXIT’ will return the selection to the first item of the Main 
Menu. 

 
 
 

a. Select Probe 
 

The display will show as below if you select ‘SELECT PROBE’ menu from the main menu. You can enter a 
new probe, delete a probe, or select an existing probe from this section. 

 

       METAL SAMPLES                             MS4500E/MS4500E-HC 
 

SELECT PROBE 
MAKE MEASUREMENT 
RECALL READINGS 
DELETE READINGS 
SET TIME & DATE 
SET MEASUREMENT TIMER 
COMMUNICATIONS 
LANGUAGE / IDIOMA / LINGUAGEM 
BACKLIGHT ON/ OFF 
POWER OFF 

FW-1890-02.00                                     12/15/2022 09:10:54 

ENTER NEW PROBE  

DELETE EXISTING PROBE  
1000: WIRE LOOP PL:10.0 
2500: CYLINDRICAL PL:10.0 
2500: CYLINDRICAL PL:10.0 
0434: TUBE LOOP PL:10.0 

 
 MORE > 
 
 

PRESS ENTER TO SELECT 
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ENTER NEW PROBE ‐ To enter the ID of a new probe, select ‘ENTER NEW PROBE’; the next screen 
allows you to enter the ID number and the type. 

 
1. Enter the Probe ID using the number keys. (Use the Up/Down arrows to scroll between 

alphanumeric characters. Use the Right/Left arrows to advance to the next character or go back to 
the previous character.) When a 4‐digit Probe ID is entered the cursor automatically advances to 
the Probe Type field. 

2. Use the Up/Down arrows to select the Probe Type. Use the Right arrow to advance to the Probe 
Life field. 

3. Enter the Probe Life using the number keys. 
4. Press ENTER. 

 

 

SELECT EXISTING PROBE 
 

To assist you with selecting a probe ID, the screen displays a list of all probe IDs currently in memory. 
Select from the list of probes in memory the one for which you wish to run a function (Make 
Measurement, Recall Readings and Delete Readings). 

 

o Press the arrow key to select a probe ID. 
o Press ENTER. 

 
 
 

PROBE ID: 5385  

PROBE TYPE: WIRE 40  

PROBE LIFE: 10.0 

 
PRESS ENTER TO SET 

ENTER NEW PROBE DELETE EXISTING PROBE 
1000: WIRE LOOP PL:10.0 
2500: CYLINDRICAL PL:10.0 
2500: CYLINDRICAL PL:10.0 
0434: TUBE LOOP PL:10.0 

 
 
 
 

PRESS ENTER TO SELECT 
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DELETE EXISTING PROBE 
 

It is occasionally necessary to remove the ID of a probe from memory, for example: 
o When the memory bank is full 
o When a probe is no longer used 

 
To delete the ID of a probe in memory, select DELETE EXISTING PROBE. 

 
 

 
 
 

1. Enter the probe ID ‐ use Up/Down arrow keys to change. 
2. Press the Enter Key when you’ve entered the correct ID number. 
 
The instrument will delete your choice of probe ID from memory. 
 
 
 

  

 
DELETE PROBE 

 
 

PROBE ID: 1000 
 
 
 
 
 

USE UP / DOWN ARROW TO CHANGE  
PRESS ENTER TO DELETE 
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b. Make Measurement 
 
 

Select a probe before you run the function 
In order for you to run ‘MAKE MEASUREMENT’  ‘RECALL READINGS’ & ‘DELETE READINGS’, 
you must have already selected a probe from memory. See ‘SELECT PROBE’ from the Main 
menus (page 8). 

 

 
To take measurement from probes in memory, select ‘MAKE MEASUREMENT’ menu from 
the Main Menu: 

 
The next screen displays the probe ID that you selected earlier from the Main Menu item 
‘SELECT PROBE ’. 

 

 
 
Press ‘ENT’ button to start measuring the probe value. During measurement ‘MEASURING.. ‘ 
message displays on the screen. On completion of measurement the display shows the 
probe reading. 
Press ‘ENT’ button to save the reading. Press ‘Up’ Arrow to re‐measure the probe again. 

 
 
 

PROBE ID:1234 
TUBE 

 
 
 
 
 

PRESS ENTER TO START 

PROBE ID:1234 

PREVIOUS METAL LOSS 
PREVIOUS CORROISON RATE 
 

: 8.61 mils 
: 1.01 mpy 
   

MEASURING 
 
METAL LOSS  : 8.50 mils 
PROBE CHECK  : 870.0 

 
PRESS UP ARROW TO REMEASURE 
PRESS ENTER TO SAVE 

       METAL SAMPLES                             MS4500E/MS4500E-HC 
 

SELECT PROBE 
MAKE MEASUREMENT 
RECALL READINGS 
DELETE READINGS 
SET TIME & DATE 
SET MEASUREMENT TIMER 
COMMUNICATIONS 
LANGUAGE / IDIOMA / LINGUAGEM 
BACKLIGHT ON/ OFF 
POWER OFF 

FW-1890-02.00                                     12/15/2022 09:10:54 



13  

 
 
 
 
 
 
 
 
  
 
 

 

PROBE ID:1000 

PRESS ENTER TO CR 
 

c. Recall Readings 
 

Select ‘RECALL READINGS’ to look at data from different dates. 

 
Select the probe if it is not already selected to look in to the readings by using up/down 
arrows and press ‘ENT’ button. The readings of the selected probe will be displayed in the 
next screen. 

 

 
RDG# READING DATE(M/D/Y) TIME CHECK 
8 4.05 04/24/22 18:45 809 
7 4.10 04/24/22 18:45 704 
6 4.10 04/24/22 18:45 705 
5 4.15 04/24/22 18:45 809 
4 4.26 04/24/22 18:45 704 
3 4.29 04/24/22 18:45 705 
2 4.50 04/24/22 18:45 809 
1 4.50 04/24/122 18:45 809 

 
   
  
 
 

 
 

 

ENTER NEW PROBE  

DELETE EXISTING PROBE  
1000: WIRE LOOP PL:10.0 
2500: CYLINDRICAL PL:10.0 
2500: CYLINDRICAL PL:10.0 
0434: TUBE LOOP PL:10.0 

 
 
 
 

PRESS ENTER TO SELECT 

PROBE ID :10000 
F        1  12/19/22 RDG  : 137.16    ML : 1.37 
L        9   12/21/22 RDG : 902.306   ML : 8.02 

    
COR RATE: 1208.12 MPY 

                               
                First Reading Number :  00000 
                Last Reading Number :  00000 
 
 
               PRESS DOWN KEY TO GRAPH 
              < ENT = UPDATE> 
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Enter First number and Last reading number to calculate Corrosion Rate and Press Enter. 
Press Down arrow on the keypad to plot the graph of the selected probe. The graph will be 
displayed on the next screen. 
 

• The corrosion rate page appears as the image below: 

PROBE ID:1000 
P  1000 R 
O B E 

500 

L 04/01/15 
RDG : 860.04 

ML : 8.60 R 
04/27/15 
RDG : 860.32 
ML : 8.60 

U 
N I 
T 
S 

COR RATE: 
0.05 MPY 

 124 248 372 
# OF READINGS 

496 
<ENT = UPDATE> 
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PROBE ID:1000 

PRESS ENTER TO DELETE 

d. Delete Readings 
 

Select ‘DELETE READINGS’ from Main Menu to erase a reading from memory. 
Periodically delete readings to create more free storage area in memory. 

 

 

 

Select the probe from which the readings need to be deleted by using up/down arrows and 
press ‘ENT’ button. The readings of the selected probe will be displayed in the next screen. 

 

 
RDG# READING DATE(M/D/Y) TIME CHECK 
8 4.05 04/24/22 18:45 809 
7 4.10 04/24/22 18:45 704 
6 4.10 04/24/22 18:45 705 
5 4.15 04/24/22 18:45 809 
4 4.26 04/24/22 18:45 704 
3 4.29 04/24/22 18:45 705 
2 4.50 04/24/22 18:45 809 
1 4.50 04/24/122 18:45 809 

 
 
 
 
 

Select the probe reading (RDG#) number which needs to be deleted by using up/down arrows 
and press ‘ENT’ button. The selected probe reading will be deleted permanently from the 
instrument memory. 

ENTER NEW PROBE DELETE EXISTING PROBE 
1000: WIRE LOOP PL:10.0 
2500: CYLINDRICAL PL:10.0 
2500: CYLINDRICAL PL:10.0 
0434: TUBE LOOP PL:10.0 

 
 
 
 

PRESS ENTER TO SELECT 
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e. Set Time & Date 
 

Select ‘SET TIME & DATE’ from Main Menu to set the internal clock of the MS4500E 
Data Logger. In order for information in memory to be useful and accurate, be sure the 
time and date are accurate. 

 
 
 

CAUTION: The Time and Date are set at the factory, but may need to be adjusted to your 
time zone. Also, if you try to change the Date or Time and it conflicts with stored 
information, the MS4500E will display N/A. 

 
ATTENTION : l'heure et la date sont définies à l'usine, mais ils peuvent être ajustées à votre 
fuseau horaire. Aussi, si vous essayez de changer la date ou l'heure et que ce ci conflit avec 
l'information mémorisée, le MS4500E affichera N/A. 

 
 

 
Use the numbers on the keypad and the arrow keys to make changes to the time and date. 

 

Press ‘ENT’ button on the keypad to confirm your changes and return to the Main Menu , or 
Press ‘EXIT’ button to discard the changes. 

 
 

DATE (MM / DD / YY): 
04 / 27 / 15 

 
TIME (HH:MM): 

03: 42 PM 
 
 

USE LEFT / RIGHT ARROW TO SELECT USE UP / DOWN ARROW 
TO CHANGE PRESS ENTER TO SAVE 
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f. Set Measurement Timer 
 

Select ‘SET MEASUREMENT TIMER’ from Main Menu to set automatic probe 
reading at set intervals. The MS4500E Data Logger periodically wakes up and takes the 
measurement and stores the reading. 

Select a probe before you run the function 
In order for you to run MAKE MEASUREMENT, you must have already selected a probe 
from memory. See Select Probe ID from the Main menus (see page 8). 

 
 

 
 

If probe is not selected earlier, select the probe from the display. Use Up/Down arrow 
keys to select the probe and press ‘ENT’ button. 

 
 
 
 

Use Right/Left arrow keys to turn on/off the data logging. Use Up/Down arrow to 
change data logging interval. Minimum can be set as 1 Hours and maximum can be set 
as 99 Days. The unit takes the reading once per the set interval. 

ENTER NEW PROBE DELETE EXISTING PROBE 1000: 
WIRE LOOP PL:10.0 
2500: CYLINDRICAL PL:10.0 
2500: CYLINDRICAL PL:10.0 
0434: TUBE LOOP PL:10.0 

 
 
 
 

PRESS ENTER TO SELECT 

DATA LOGGING INTERVAL SETUP PROBE ID : 2500 
 

SELECT DATA LOGGING INTERVAL: ONCE EVERY 1 HOURS 
 

LOGGING OFF 
 
 

RIGHT / LEFT ARROW TO TURN ON/OFF UP/DOWN ARROW TO 
CHANGE INTERVAL PRESS ENTER TO SAVE 
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g. Communications 
 

The MS4500E Data Logger has the ability to store readings as they are taken. These 
readings can later be transferred to your PC via USB port. To transfer data to a PC it is 
necessary to install the Corrosion Data Management Software (included). 

 
To connect to the MS4500E to PC, the use of the Certified USB Barrier Metal Samples Part 
#ET1867 must be used while in in the Non-Hazardous Area only.  The connection is made via J5 
on the MS4500E-XX to download the Data to the PC. 
 

 
Warning: Connection shall only be made while both  

equipment and barrier are located in a non-hazardous area. 
 

 

 
WARNING: 
Improper connection to the PC may cause permanent damage to the MS4500E.   
 
AVERTISSEMENT: 
Une mauvaise connexion au PC peut causer des dommages permanents au MS4500E. 
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To download data from an instrument: 
 

• Connect the instrument to an available PC USB port . 
• Turn the MS4500E on. 
• Run the Corrosion Data Management Software 
• Open the Instrument Download Center 
• Select the serial port and instrument 
• Click the Download button, then “Connect” (ensure that Part Status toggles to “On”). 
• Select ‘COMMUNICATIONS’ menu from the Main Menu of the instrument. 
• Select ’TRANSFER ALL’  or Select the Probe data you wish to download. 

 

 
Data will begin to transfer from the instrument to the PC, and will appear in the data window of the 
Instrument Download Center as shown below. If the data appears garbled, the wrong instrument 
type has been selected. Select another instrument type and try again. 

 

TRANSFER ALL 1001:  WIRE LOOP 
 
 
 
 
 
 
 
 
 

PRESS ENTER TO TRANSFER 
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If data does not appear in the data window at all, verify that: 
 

• The instrument is connected to a valid serial or USB port 
• All cables are securely connected 
• The message “Port Status: On” appears in the status bar 
• There are no errors on the instrument 
• If using a USB adapter, ensure that the device drivers have been installed. 

 
 

Selecting a Serial Port 
When the MS4500E is connected to the USB port it will appear as a virtual COM port. Use the 
Serial Port selection box to select the virtualCOMport number. If the COM port number is 
unknown, it can be found in Windows Device Manager under “Ports (COM & LPT)”. 

 
Selecting an Instrument 
Use the Instrument option box to select the model of Metal Samples instrument being downloaded. 
This sets the appropriate communication parameters, which will be displayed in the status bar at the 
bottom of the window (“9600,N,8,1” for an MS1500, “2400,N,8,1” for an MS3500). 

 
Downloading Data 
To toggle the selected port on and off, click the Download button. Toggling the port on and off 
will also clear the data window. 

 
Once a valid serial port and instrument have been selected, click the Download button to turn the 
port on and enable the computer to receive data. If a valid serial port has been selected, the 
status bar at the bottom of the window will display the message “Port Status: On”. 
If an invalid serial port has been selected, an error message will appear, and the status bar will display 
the message “Port Status: Off”. If this happens, another serial port should be selected. 

 
Saving Data 
To save the data in the data window, click the Save button. The data is comma‐delimitedASCII text. 
It can be saved to a standard text (.txt) file, or it can be saved to a comma‐separated values (.csv) file, 
which greatly simplifies the process of importing the data into some spread‐ sheet programs such as 

Excel® or Quattro Pro®. 
 

Printing Data 
To print the contents of the data window, click the Print button. Aprint dialog box will be displayed to 
allow printer selection and setup. 

 
Charting Data 
To chart the contents of the data window, click the Chart Data button. If the data has not yet been 
saved, the user will be prompted to do so before the charting process begins. For more information 
on charting data, see the DataAnalysis section. 
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Data Analysis 

The DataAnalysis utility is a convenient tool for charting data from Metal Samples ER and LPR data 
logger instruments. The DataAnalysis utility can be opened from the Main Menu, or it can be 
opened directly from the Instrument Download Center. 

 
If the DataAnalysis utility is opened from the Instrument Download Center, the contents of the data 
window will be loaded into the chart. However, if the DataAnalysis utility is opened directly from the 
Main Menu, a valid data file must be loaded. The Select File box will open to allow selection of a 
data file. 

 
Loading a Data File 
After selecting a data file (or clicking the Chart Data button from the Instrument Download Center) a 
status window will display the progress of the file being opened, along with the Instrument Type, 
Probe Type, and Probe ID for the data file. 

 

 
Data Table 
After a file has been successfully loaded, the data will be displayed in the Data Table for review. By 
default, all data points will be included in the chart. However, data points can be turned off, or 
excluded, from the chart. If the “Excluded” flag appears in the status column for a data 
point that data point will not appear in the chart. To toggle the exclude/ include status of a data 
point, double‐click the data point, or select the data point and click Exclude/Include in the Options 
menu. 
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Printing Data 
The data table can be printed by clicking Print in the Options menu. A print dialog box will be displayed 
to allow printer selection and setup. 

 
CreatingAChart 
To chart the selected data, click the Chart 
Data button, or select Chart Data from the 
Options menu. The chart will be displayed in a 
new window. 

 
 
 
 
 
 
 
 
 

Printing a Chart 
A chart can be printed using the Print Chart option in the File menu. 
A print dialog box will be displayed to allow printer selection and setup. 

 
Exporting a Chart 
A chart can be exported to other applications using the Copy Chart option in the File menu. This will 

copy both the chart and the raw data to the Windows® Clipboard. The chart can then be inserted 
into other applications using the Paste function. Note: In some applications, using the Paste function 
will insert the raw data instead of the chart. In this case, use the Paste Special function, then select 
Picture to insert the chart. 

 
 
 
 

 
Chart Tools 

 
• Statistical Data 

The Statistical Data tab at the bottom of the Data Chart 
window will display a page with statistical information about 
the chart data. If the Statistical Data page is visible, this 
information can be printed by clicking Print Statistical Data 
in the File menu. 
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• Finding A Data Points Value 
While viewing the chart, the value of any data point can be determined by simply clicking it. The value 
will be displayed in the charts tool‐tip box (a small text box that is displayed near the mouse pointer). 
If the tool‐tip box does not appear immediately after clicking the data point, hold the mouse pointer 
stationary over the chart background for a moment. 

 
 
 

• The Tools Menu 
 

The Tools menu contains a collection of utilities for viewing and 
manipulating the chart. The Tools menu can be accessed by clicking 
Tools on the menu bar, or by right‐clicking anywhere on the chart. 

 
 
 

o Data Markers 
Show Data Markers toggles the data markers on and off. 

 
o Mean Value 
Show Mean Value toggles the mean value line on and off. 

 
o Trend Line 
Show Trend Line toggles the trend line on and off. 

 
o Title/Footnote Setup 
Title/Footnote Setup displays a window that allows the chart title and footnotes to be toggled 
on and off, and to be modified. 

 
o Plot Setup 
Plot Setup displays a window that allows configuration of Y‐axis scaling, and of the chart type. 

 
TheY‐axis can be scaled to default values by checking the Auto Scaling option box. The Y‐axis 
can be scaled to manual values by un‐checking the Auto Scaling box, then entering the 
desired values in the Minimum and Maximum fields. 

 
The chart type can be set to Line Chart, Bar Chart, or Area Chart by selecting the 
appropriate button in the Chart Type box. The default chart type is Line Chart. 

 
o Data Series Color 
Data Series Color displays a color selection box, which allows the user to select the brush color 
for the plot line. The default color for the plot line is Blue. 
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o Zoom In 
Zoom In allows a region of the chart to be enlarged so that it may be viewed in greater detail. 
To enlarge a region of the chart, click on the two data points that define the left and right 
boundaries of the region. 

 
In zoom mode, the mouse pointer will change to a cross‐ hair. When zoom mode ends, the 
mouse pointer will return to its normal state. 

 
To cancel zoom mode, click Cancel Zoom In from the Tools menu, or simply press the Esc key. 

 

o Zoom Out 
Zoom Out restores the initial view of the chart, which displays the full data set. 

 
o Calculate Corrosion Rate 
If the chart contains ER data, the Calculate Corrosion Rate option will become available under 
the Tools menu. This option allows the corrosion rate to be calculated between any two data 
points on the chart. To calculate the corrosion rate click Calculate Corrosion Rate, then click 
two data points. The corrosion rate between those two data points will be displayed. 
In calculate mode, the mouse pointer will change to an arrow/question mark. When 
calculate mode ends, the mouse pointer will return to its normal state. 

 
To cancel a calculation, click Cancel Calculate from the Tools menu, or simply press the Esc key. 
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h. File Transfer USB 
 

The J9 Connector on the top side of the device allows for transferring of data onto USB flash 
drives. 
 
Hazardous Area     
In the hazardous area, the Metal Samples Part# ET1650 Certified USB flash drive can be used.  All 
other non-certified drives must be used in the safe area. 
 
Connection: 

  

 
CAUTION: 
Only certified flash drives may be connected and used in the hazardous location. 
 
ATTENTION: 
Seuls les lecteurs flash certifies peuvent être connecté et utilisé dans l'emplacement dangere 
 

To download the Data from the “Main Menu” select 7. Communications after installing the USB 
drive in J9. 
 

 
The up arrow can be pressed, and you can select download all by pressing ‘ENT’ or you can 
individually select the probe you are interested in by scrolling through the list with the arrow 
keys and selecting the probe(s) of interest by pressing ‘ENT’ on each one.  

       METAL SAMPLES                             MS4500E/MS4500E-HC 
 

SELECT PROBE 
MAKE MEASUREMENT 
RECALL READINGS 
DELETE READINGS 
SET TIME & DATE 
SET MEASUREMENT TIMER 
COMMUNICATIONS 
LANGUAGE / IDIOMA / LINGUAGEM 
BACKLIGHT ON/ OFF 
POWER OFF 

FW-1890-02.00                                     12/15/2022 09:10:54 
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i. Language / Idioma / Linguagem 
 

Select ‘LANGUAGE / IDIOMA / LINGUAGEM ’ from Main Menu to select the 
language. 

 
 
 

 
 

j. Backlight On/Off 
 

Select ‘BACKLIGHT ON/OFF’ from Main Menu to turn the backlight for the LCD display 
on or off. 

 
k. Power Off 

 
Select ‘POWER OFF’ from Main Menu to turn off the unit. 

 

 

 

ENGLISH  

ESPANOL  
PORTUGUES  

FRANCAISE 
 
 
 
 

PRESS ENTER TO SELECT PRESIONAR ENTPARA 
SELECCIONAR PRESSIONAR ENT PARA AJUSTAR TAPER 
ENTRER POUR REGLER 

 
 
 
 
 

LOGGING OFF 
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C. Maintenance 
Once installed, the MS4500E High Resolution ER Data Logger requires no maintenance. However, it is 
important to verify the following items periodically to ensure continued safe  operation. 

 

CAUTION: Before performing any tests or maintenance on the MS4500E High Resolution ER Data 
Logger, ensure that all hazardous area requirements are met. 

 
ATTENTION : Avant d’effectuer tout essai ou entretien de l’enregistreur de données de haute 
résolution MS4500E, il faut d’abord s’assurer que toutes les exigences de zone dangereuse soient 
remplies. 

 

 
Inspection Item Frequency 
Inspect the rubber boot for any signs of damage. Replace as necessary. Annually 
Inspect the probe cable / connector for any signs of damage. Replace as necessary. Annually 
Replace the Batteries As needed 

 

Contact Metal Samples for replacement parts or if instrument repair is necessary. 
 
 

 
Testing the MS4500E High Resolution ER Data Logger with the Meter Prover 

 

A Meter Prover is provided to allow routine checks of the MS4500E High Resolution ER Data Logger. The 
Meter Prover simulates a Wire Loop type probe at a fixed value. To test the unit with the Meter Prover: 

 
1) Connect the Meter Prover to the probe connector . 
2) Turn on the MS4500 data logger by pressing the ‘ON’ button 
3) Select probe type as Wire Loop. 
4) Set mils to 10 
5) Select MAKE MEASUREMENT From main menu . 
6) Press ‘ENT’ button to start measuring the probe value. During measurement ‘MEASURING. ‘ 
message displays on the screen. On completion of measurement the display shows the Meter Prover 
reading. The output should closely match the value printed on the Meter Prover label. 

 
If the Data Logger output matches the Meter Prover value, the instrument can be used for probe 
measurement by selecting the appropriate PROBE ID and connecting to the respective probe. If the Data 
Logger output shows a significant difference compared to the Meter Prover value, further 
troubleshooting may be required. Refer to page 28 for troubleshooting or contact the factory for 
further assistance. 
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D. Troubleshooting 

If the MS4500E High Resolution ER Data Logger does not seem to perform as expected, check the following 
items: 

 
CAUTION: Before performing any tests or maintenance on the MS4500E High Resolution ER Data 
Logger, ensure that all hazardous area requirements are met. 

 
ATTENTION : avant d'effectuer tout essai ou d'entretien sur l'MS4500E haute résolution ER Enregistreur 
de données, s'assurer que toutes les conditions sont remplies pour zone dangereuse. 

 

1. Ensure that the probe is operational and is not completely corroded. This can be done in two ways. 
a. Test the probe with another portable ER meter if available. 
b. Test the probe with a portable resistance or continuity meter as follows: 

i. Connect one test lead to pin ‘A’ of the probe’s 6‐pin connector. 
ii. Measure continuity to each of the other pins. There should be continuity (low 

resistance) to each pin. 
NOTE: Continuity on each pin does not ensure that the probe is good. However, if you 
find an open circuit on any pins then it is almost certain that the probe is bad and should 
be replaced. 

2. Ensure the battery voltage. 
3. Test the MS4500E High Resolution ER Data Logger transmitter using the supplied Meter Prover (see 
page 27.) 

 
These basic checks should indicate the source of any problem (probe, power supply, wiring, etc.). If it is 
determined that the MS4500E High Resolution ER Data Logger is malfunctioning, or if you need further 
assistance in troubleshooting, contact Metal Samples Technical Support. 

 

 
CAUTION: If the MS4500E High Resolution ER Data Logger transmitter shows any signs of damage, remove 
it from service immediately and consult the factory. 

 
ATTENTION: Si l’Émetteur de l’Enregistreur de données de haute résolution présente des signes de 
dommages, Alors il faut le retirer du service et consulter l’usine. 



29  

III. Service and Warranty Information 
 

A. Warranty 

Metal Samples warrants that any part of the model MS4500E High Resolution ER Data Logger and 
accessories which proves to be defective in material or workmanship within one year of the date of 
original shipment to Purchaser will be repaired or replaced, at Metal Samples option, free of charge. This 
warranty does not cover (1) probe assemblies, (2) items expendable in nature, or (3) items subject to 
damage from normal wear, misuse or abuse, or failure to follow use and care instructions. 

 
All damaged items are to be shipped at Purchaser’s expense to and from Metal Samples which shall have 
the right to final determination as to the existence and cause of a defect. 

 
The foregoing shall constitute the sole and exclusive remedy of any purchaser of Metal Samples products 
for breach of warranty and IS EXCLUSIVE AND IN LIEU OF ALL OTHER WARRANTIES, EXPRESSED, IMPLIED OR 
STATUTORY, INCLUDING THE IMPLIED WARRANTIES OR MERCHANTABILITY AND FITNESS. IN NO EVENT 
SHALL METAL SAMPLES BE LIABLE FOR SPECIAL OR CONSEQUENTIAL DAMAGES, OR FOR ANY DELAY IN 
THE PERFORMANCE OF THIS WARRANTY DUE TO CAUSES BEYOND ITS CONTROL. 

 
The technical information and suggestions contained herein are believed to be reliable, but they are not to 
be construed as warranties since conditions of use are beyond our control. 

 

B. Obtaining Service and Returning the Instrument for Repair 
 

If you experience problems with your instrument please contact the factory at 256‐358‐4202 and ask for 
customer support for instrumentation. Our customer support department will assist you in 
troubleshooting your instrument. 

 
Most issues can be resolved over the phone, but in some cases it may be necessary to return your 
instrument for further evaluation and repair. In this case, please obtain a Return Materials Authorization 
(RMA) number from the sales person or support technician. This RMA number will ensure that your 
instrument is routed to the correct department when it is received at the factory. 

 
After receipt of an RMA number you may pack your instrument for return. Be sure to pack your instrument 
in a sturdy box and to pad it sufficiently to avoid damage during transit. Also be sure to complete the 
“Instrument Repair Form” on the next page and include a copy with your repair. This will ensure that the 
repair department has sufficient information regarding the problems you are experiencing with your 
instrument, as well as the billing, contact, and return shipping details for the repair. 

 
Once you have obtained an RMA number, completed the “Instrument Repair Form”, and packed your 
instrument securely, please ship it prepaid to the following address: 

 
Metal Samples 
152 Metal Samples Road 
Munford, AL 36268 
ATTN:  RMA# _ _ _ _ _ 

 
NOTE: Be sure to list your RMA number in the attention line (shown as blanks in the example above.) 
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C. Instrument Repair Form 

This form may be photocopied for use when returning an instrument to Metal Samples for repair. 
Please fill in all known information and enclose a copy of the completed form with the instrument. 

 

 

  
 

  
*If known. 

 

 

  
 

  
 

 

  
 

 
*If different than above. 

 

 
 

 
 

 
 

 
 

 
 
 

Reference 
PO# 

 

Model 
Number 

Serial 
Number 

RMA 
Number 

Date of 
Purchase* 

Contact 
Name 

 
Company 

Phone 
Number 

E‐mail 
Address 

Recipient 
Name* 

 
Company* 

 
 
 

Return 
Address 

Contact me for credit card information 
(For security purposes, do not list credit card information on this form..) 

General Information 

Contact Information for Repair 

Return Shipping Information 

Reason for Return. (Provide as much detail as possible. Attach additional pages if required.) 

Invoice Instructions (For non‐warranty repairs) 

Invoice me for the repair    
(Requires an open account with Metal samples.) 
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Appendix A: Revision History 
 

Revision Date Changes 
0 8/15/2014 Initial Release 
A 5/22/2015 Mini USB entity parameters changed 
B 6/01/2015 Mini USB entity parameters changed 
C 7/19/2015 Marking information added for America 
D 8/04/2015 Warning statements added in French & Temperature ratings 
E 10/06/2016 Backlight On/Off added to main menu 
F 4/09/2019 New Hazardous Location standards added 
G   05/31/2019 Changes to Technical Specifications page 
H 07/25/2022  Certification details updated. 
I 01/26/2023  Picture representation corrected 
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Appendix B: Hazardous Area Certification Details 
 



 

 



 

 
 
 



 

 
Appendix C: Drawing 

 
 

Control Drawing (Hazardous Area Wiring Diagram) 
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